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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skeermen.
Tag den tid du behgver for at leese vejledningen,
inden du bruger skaermen. Den indeholder
vigtige oplysninger om bemaerkninger angdende
brugen af din skarm.

Philips garanti deekker under forudsatning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

D Advarsler

Anvendelse af betjeningselementer; justeringer
eller fremgangsmader, der ikke er beskrevet i
denne dokumentation, kan resultere i elektrisk
sted, elektriske ulykker og/eller mekaniske
ulykker:

Lees og felg disse vejledninger, nar du tilslutter
og anvender din computerskarm.

Betjening

* Hold venligst skeermen veek fra direkte
sollys, meget staerkt og lyst lys samt fra alle
varmekilder. Laengere tids udseettelse for
sadan et miljg kan resultere i misfarvning
og skade pa skeermen.

* Fjern alt, der kan risikere at falde i
ventilationsdbningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

* Bloker ikke ventilationsdbningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til stremstikket
og stikkontakten.

* Hvis der slukkes for skeermen ved at fjerne

stremkablet eller jeevnstremsledningen,
skal du vente 6 sekunder, for du setter

stremkablet eller jeevnstremsledningen til
igen for at opnad normal betjening.

e Brug altid et godkendt strgmkabel, der
er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

*  Udset ikke skaermen for kraftige
vibrationer eller stad under anvendelse.

»  Sla ikke pa skeermen, og undga at tabe den
under brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du
undga at trykke kraftigt pa LCD skeermen.
Nar du flytter din skeerm, sa tag fat
om rammen for at Igfte den. Laft ikke
skaermen ved at sette din hand eller fingre
pa LCD skarmen.

* Tag stikket ud fra skeermen, hvis du ikke
skal bruge den i en lengere periode.

* Tag stikket ud at kontakten til skaermen,
hvis du skal renggre den med en let fugtet
klud. Skeermen kan terres af med en ter
klud, nar der er slukket for strammen.
Under alle omstandigheder, ma der ikke
bruges organiske oplasningsmidler til
rengering af din skeerm.

* For at undga risiko for elektrisk sted eller
permanent beskadigelse af anleegget, ma du
ikke udseette skeermen for stev, regn, vand
eller miljger med hgj fugtighed.

*  Huvis din skaam bliver vad, skal den tarres af
med en ter klud sa hurtigt som muligt.

e Hvis der kommer fremmed substans eller
vand ind | skeermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skarmen til servicecenteret.

e Skermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* Forat opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skeermen et sted, der



er indenfor fzlgende temperatur- og
fugtighedsomrade.
e Temperatur: 0-40°C 32-95°F
*  Fugtighed: 20-80 % RH

*  VIGTIGT: Serg altid for at aktivere
en pauseskeerm, der beveeger sig, nar
skaermen efterlades uden at blive anvendt.
Du skal altid bruge en pauseskeerm
eller et andet program, der opdaterer
skeermen regelmeessigt, hvis skeermen
viser statisk materiale i leengere perioder.
Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skaermen.

“Braendmaerker”, “efterbilleder”, og
“spegelsesbilleder” er et velkendt
feenomen i LCD skaermteknologi. | de
fleste tilfelde vil “brandmaerkerne” eller
“efterbilledet” eller “spagelsesbilledet”
forsvinde gradvist, efter skaermen er
blevet slukket.

O Advarsel

Alvorlig “brandmeerkerne’- eller “efterbillede”-
eller “spagelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennavnte skade
er ikke daekket af garantien.

Service
e Kabinettet ma kun dbnes af kvalificeret
servicepersonale.

* Huvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
“Kundeinformationscenter’)

* For oplysninger om transport, se
“Tekniske specifikationer”.

» Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

% Bemaerk

Kontakt en servicetekniker; hvis skaeermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal gare, ndr betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemarkninger, forholdssregler og advarsler

I hele denne vejledning kan tekstafsnit veere
ledsaget af et ikon, og sta med fed eller kursiv
skrift. Disse afsnit indeholder bemaerkninger og
punkter, hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som fglger:

© Bemerk

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan gere bedre brug af
computersystemet.

0 Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader; og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/

sustainability/recycling,




2 Opszetning af sk&r‘m B Installation af stander

1. Anbring skeermen med forsiden vendt
nedad pa en bled og jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

1] Emballagens indhold 2. Fastger fodsgjlen pa skeermen, sa den laser

sig selv pa plads.
Quick E
Start

PHILIPS

............

3. Hold pa skaermens stander med begge
haender, og st med en fast hand standeren
ind i fodsgjlen.

VGA (valgfri) DVI (valgfri)




E Tilslutning il PC

PHILIPS

© AC stromindgang
© VGA-indgang
© DVI-D-indgang (tilgaengelig pa udvalgte

modeller)

O Lyd-indgang (tilgeengelig pa udvalgte

modeller)

© Kensington anti-tyverisikring

Tilslutning til pc

1.

Tilslut ledningen ordentligt pa bagsiden af
skaermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pa computeren.

Seet computerens og skaermens
netledninger til et stik i neerheden.

Teend for computeren og skaermen. Hvis
skeermen viser et billede, er installationen
gennemfart.

2.2 Brug af skaerm

El Produktbeskrivelse set forfra

PHILPS

L

Model 226V3LA:

(5]
AUTO/ W 1J/A 0/ 4 /0K 0}
© o 6o o o
Model 226V3L:
(5]

AUTO/Y  ED/A O/ /0K [0)
6o 6 066 6 o
@ (O |[Tander og slukker for skermen.

Sédan far du adgang til OSD-
0 =)/0K Meuen

Bekreeft justering af
skeermmenuen.

Ga tilbage til det forrige OSD-

o < niveau.

O | O |Justerer lysstryken.

© | A V¥V [Tiljustering i skeermmenuen.
1 |Juster lydstyrken.

4 O |Skifter skeermformat.

©@ | AUTO |Juster skaermen automatisk.




2. Opsatning af skarm

Bl Beskrivelse af OSD-visningen
Hvad er OSD (On-Screen Display)?

Visning pa skaermen [On-Screen Display
(OSD)] er en funktion pa alle Philips LCD
skeerme. Den szetter en slutbruger i stand

til at justere skeermindstillingerne, eller

vaelge skeermens funktioner direkte via et
instruktionsvindue pa skeermen. Et brugervenligt
skaeermvisningsinterface vises som nedenfor:

Model 226V3LA:

Grundlzggende og enkle anvisninger til
kontrolknapperne

| skeermmenuen ovenfor, kan du bruge

V A knapperne foran pd skeermen til at flytte
markgren med, og tryk pa OK knappen, til at
bekreefte dit valg eller eendring.

OSD-menuen

Nedenstdende er en generel oversigt over

strukturen i OSD-displayet. Du kan anvende
den som opslag, nar du senere skal orientere
dig i de forskellige justeringer.

Main menu

— Input

Sub menu

I: VGA
DvI

(available for selective models)

— Picture

— Audio

— Picture Format
— Brightness
— Contrast

— SmartContrast

— Volume

— Stand-Alone

— Mute

(available for selective models)

— Color

— Language

— OSD Settings

L— Setup

— Color Temperature

— sRGB

— User Define

Wide Screen, 4:3
0~100

0~100

On, Off

0~100
On, Off

On, Off

6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

— English, Espafiol, Frangais, Deutsch, ltaliano,

B RS, Turkge

Portugués, Pycckui,

r— Horizontal
— Vertical
— Transparency

— OSD Time Out

— Auto
— H. Position
— V. Position
— Phase

— Clock

— Reset

L Information

— Resolution Notification

0~100
0~100
Off,1,2,3,4

5s, 10s, 20s, 30s, 60s

— 0~100
— 0~100
— 0~100
— 0~100
— On, Off
— Yes, No



2. Opsatning af skerm
E Meddelelse om oplasning

Denne skarm er fremstillet til optimal ydelse
pa dens native oplgsning, som er 1920 x 1080
@ 60 Hz. Nar skeermen bruger en anden
opl@sning, ses falgende advarsel pa skeermen:
Brug 1920 x 1080 @ 60 Hz for at opna det
bedste resultat.

Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i
OSD (skaermmenuen).

a Fysisk funktion
Vip

2.3 Fjern standeren og foden

Kl Fijernelse af foden

Inden du begynder at adskille skeermens fod,
skal du felge vejledningerne nedenfor for at
undga mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jaevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

N

Tryk pa laseklemmerne for at fierne foden
fra sgjlen.




2. Opsatning af skerm

2] Fjernelse af foden

1. Du kan bruge en almindelig skruetraekker
til at stikke ind i de to frigivelseshuller pa
haengslet, og lirk forsigtigt i heengseldeekslet
for at fierne det.

2. Fjern de 4 skruer og fiern derefter foden
fra skaermen.




3. Billedoptimering

3.1 SmartContrast

Bl Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skaermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
daemper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pd en mark
baggrund.

B Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, leesbar tekst ved kontorarbejde.Ved at
nedsatte skeermens stremforbrug, sparer du
energiomkostninger og forlenger skaeermens
levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og
baggrundslysets intensitet indstilles. Denne
funktion forbedrer den dynamiske kontrast og
giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.2 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skaermen
via et nemt, grafisk interface. Komplicerede
justeringer hgrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af oplgsning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er

udstyret med den seneste teknologi i algoritmer

for hurtig behandling og reaktion, og er tilmed

Windows 7 kompatibel, og klar til at forbedre
din oplevelse med Philips-skaermel!

Bl Installation
* Felg instruktionen og fuldfer installationen.

¢ Du kan starte, nar installationen er fuldfart.

*  Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

PHILIPS et phita cromiicorr

Opstartsguide

* Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet forste gang.

*  Guiden leder dig trin for trin gennem
indstillingen af skeermen.

*  Du kan ogsa ga til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.

* | Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.



3. Billedoptimering
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SmartControl Lite SmartControl Lite
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Bl Start med Standard-vinduet:

[~ pe—

Adjust menu (Indstillingsmenu): SmartControl Lite

* Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),
Contrast (Kontrast), Focus (Fokus), Position
(Position) og Resolution (Oplgsning).

* Udfer indstillingen ved at folge
instruktionerne.

* Installationen kan annulleres med Cancel
(Annuller).

W Satrzenol 3 - Pl 12501 [C530713000001) X

SmartControl Lite

[ pe—
e SmartControl Lite
= =
| . I 1: - .
o k. i - !
4 e »
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3 - Poden 32501 (esLsO000m) (%
PHILIPS

Contrast

Contrast (i T ki) t0 kees decsl

Focus

3 - Poden 32501 (esLso000m1) (%
PHILIPS

Position
¢ 120 Posmion




3. Billedoptimering

W Ssastczenel 3 - i 1291 (rserisone0nt) (Bh

SmartControl Lite PHILIPS

LR}

Color menu (Farvemenu):

*  Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration
(farvekalibrering).

* Udfer indstillingen ved at folge
instruktionerne.

* Se nedenstdende oversigt med
undermenupunkter baseret pa din
indtastning.

*  Eksempel pa Color Calibration
(farvekalibrering):

[Epe— 2-prin 2258 (s se00om) ()2

SmartControl Lite PHILIPS

[ powrm,

SmartControl Lite

B totconn

SmartControl Lite

"

=

2 P 22 tesamsonsont) ()%
PHILIPS

White Point
Wiite Pomnt & ¢

2- s 7250 (a0 is00bont| T
PHILIPS

Display Gamma

2- P 72501 (i so00on) (DX
PHILIPS

Calibration

e s e

L il



3. Billedoptimering

1.

“Show Me” (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleeser far/
efter-billederne.

For at vende tilbage til Color (Farve)
vinduet, skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfere en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

Der skal veere patentoplysninger pa
kalibreringsskaermen.

Forste farvekalibreringsskaerm:

Previous (Foregaende) knappen er
deaktiveret, indtil du gar videre til den
anden farveskarm.

Next (Naste) gar til efterfelgende mal
(seks mal).

Ga til sidst til File > Presets (File > Forvalg)
vinduet.

Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden.

12

Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, nar Preferences
(Indstillinger) er valgt i Preferences (Funktioner)-
rullemenuen. Pa en ikke-understattet skeerm
med DDC/CI er kun Help (Hjalp) og Options
(Funktioner) til radighed.

[ peer— 3 - Pl 22531 (£538115

0001) (iR

SmartControl Lite PHILIPS

Preferences.

* Viser nuvarende, foretrukne indstillinger.

*  Funktionen aktiveres ved at afmaerke feltet.
Afmarkningsfeltet er en flip-flop.

* Enable Context Menu (Aktivér Indhold
menuen) er som standard afmarket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) viser
valgmulighederne i SmartControl Lite
pa Select Preset (Velg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen
ved at hgjreklikke pa skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

* Enable Task Tray (Aktiver Jobbakke)
menuen er som standard afmaerket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) ger, at
systembakkens ikon til SmartControl Lite
vises. Et hgjreklik pd jobbakke-ikonen
viser menufunktionerne for Help (Hjelp),
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).



3. Billedoptimering

Run at Startup (Ker ved opstart) er
som standard afmaerket (Til). Nar den
er deaktiveret, starter SmartControl Lite
ikke ved opstart og ikonet vises ikke i
systembakken. SmartControl Lite kan
kun startes fra genvejen pa skrivebordet
eller fra programfilen. Intet forvalg, som er
indstillet til at kere ved opstart, indleeses
nar denne boks ikke er afmaerket (er
deaktiveret).

Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows
7,Vista, XP). Standard er 0%
uigennemsigtighed.

Options > Input (Funktioner > Indgang)

er kun aktiv, nar Input (Indgang) er valgt i

Options (Funktioner) rullemenuen. Pa en ikke-
understgttet skeerm med DDC/CI er kun Help
(Hjeelp) og Options (Funktioner) til radighed.
Alle andre faneblade i SmartControl Lite er ikke
til radighed.

Vig.}
PHILIPS

[ pa——

SmartControl Lite

Input

EPORTANT!

=
-
>

Vis Source (Kilde) instruktionsvinduet og
nuvaerende indgangskildeindstillinger.

P3 enkeltindgangsskeerme ses dette vindue
ikke.

13

Options > Audio (Funktioner > Lyd) - er
kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pa en ikke-understgttet skeerm med DDC/CI
er kun Help (Hjzelp) og Options (Funktioner) til
radighed.
W Santensel T
SmartControl Lite PHILIPS

Audio

At

&

‘4

“

Help > User Manual (Hjelp >
Brugervejledning) - er kun aktiv, nar User
Manual (Brugervejledning) er valgt i Help
(Hjeelp) rullemenuen. Pa en ikke-understattet
skeerm med DDC/CI er kun Help (Hjeelp) og
Options (Funktioner) til radighed.
W Smarttores T
SmartControl Lite PHILIPS

4 Toch. Support puts

Adnrst

=

Coer

e

Optons

&

Hep

B

X



Help > Version (Hjelp > Version) - er kun aktiy,
narVersion (Version) er valgt i Help (Hjeelp)
rullemenuen. Pd en ikke-understgttet skaerm
med DDC/Cl er kun Help (Hjzelp) og Options
(Funktioner) til radighed.

[ i 3 ot (T
PHILIPS

SmartControl Lite

Version

Context Sensitive (Indholdssensitiv) menuen

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmaeerket
i Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

@ SmartControl
Helect Preset L2
Tune Display

”Context” (Indhold) menuen har tre punkter:

* SmartControl Lite - nar valgt, ses About
(Om) skaermen.

*  Select Preset (Valg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

* Tune Display (Indstil Skaerm) - abner
kontrolpanelet til SmartControl Lite.

14

Task Tray (Jobbakke) menu aktiveret
Menuen i systembakken kan ses ved at
hgjreklikke pa SmartControl Lite-ikonet
i systembakken. Et venstreklik starter
programmet.

Help

Technical Support
Check for Update
About

Exik

Jobbakken har fem punkter:

*  Help (Hjalp) - adgang til
brugervejledningsfilen: Abner User Manual
(Brugervejledningen) med standard
browservinduet.

* Technical Support (Teknisk Support) - viser
siden med teknisk support.

*  Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

*  About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

»  Exit (Afslut) - Luk SmartControl Lite.

Hvis du vil kere SmartControl Lite igen,

skal du enten veelge SmartControl Lite i
programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

PHILIPS
SmartControl

diune-standard-S2007-01-04-1151-23
Copyright 19832007 Portrat Displays, inc.
Pazsere fanang




3. Billedoptimering

Task Tray (Jobbakke) menu deaktiveret
NarTask Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).
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4. Tekniske specifikationer

Skeermpaneltype TFI-LCD
Baggrundslys LED
Panelstarrelse 21,5" W (54,6cm)
Billedforhold 16:9

Pixel pitch 0,248 x 0,248 mm
Lysstyrke (norm.) 250 cd/m?
Smart-kontrast 10,000,000:1
Kontrastforhold (norm.) 1000:1
Reaktionstid (norm.) 5ms

Optimal oplgsning

1920 x 1080 pa 60 Hz

Synsvinkel 176° (H) / 170° (V) ved C/R > 10
Skeermfarver 16,7 M

Vertikal opdateringshastighed 56Hz - 76Hz

Horisontal frekvens 30kHz - 83kHz

sRGB JA

Inputsignal

DVI (digital), VGA (Analog)

Inputsignal Separat synk,, synk. pa gren

Brugerfunktioner 226V3LA: auto/v /A Q/4 B/0K 0}
g 226V3L:  AUTO/Y /A 0/ 4 /0K 10}
OSD sprog Engelsk, Fransk, Tysk, Spansk, Italiensk, Russisk,

Simplificeret Kinesisk, Portugisisk og Tyrkisk

Andre funktioner

Kensington-las

Vip

"Plug & Play" kompatibilitet

DDC/CI, sRGB, Windows 7/Vista/XE Mac OSX, Linux

-5/+420

226V3LA:

Tendt-tilstand

2377W (typ.), 31,6W (maks.)

AC indgangsspzen-

AC indgangsspeen-

AC indgangsspeen-

Energiforbrug ding ved 100VAC ding ved 115VAC ding ved 230VAC

(EnergyStar 5.0 testmetode) +/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz

Normal funktion (norm.) 20,63W 20,49W 20,49W

| dvale (Standby) 05W 05W 05W

Fra 05W 05W 05W
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AC indgangsspeen- | AC indgangsspaen- | AC indgangsspan-
Varmetab* ding ved 100VAC ding ved 115VAC ding ved 230VAC
+/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz +/
+/- 3Hz +/- 3Hz -3Hz
Normal drift 7041 BTU 6993 BTUt 6993 BTU/
| dvale (Standby) 1,706 BTU/ 1,706 BTU 1,706 BTU/t
Fra 1,706 BTU/ 1,706 BTU/t 1,706 BTU/
Strgmdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Stremforsyning Indbygget, 100-240VAC, 50/60Hz

226V3L:

Tendt-tilstand

2325W (typ.), 28.71W (maks.)

Energiforbrug
(EnergyStar 5.0 testmetode)

AC indgangsspzen-
ding ved 100VAC
+/-5VAC, 50Hz

AC indgangsspeen-
ding ved 115VAC
+/-5VAC, 60Hz

AC indgangsspeen-
ding ved 230VAC
+/-5VAC, 50Hz +/

+/- 3Hz +/- 3Hz -3Hz
Normal funktion (typ.) 20,98W 20,85W 20,94W
| dvale (Standby) 0,5W 0,5W 0,5W
Fra 0,5W 0,5W 0,5W
AC indgangsspen- | AC indgangsspeen- | AC indgangsspaen-
Varmetab* ding ved 100VAC ding ved 115VAC ding ved 230VAC
+/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz +/
+/- 3Hz +/- 3Hz -3Hz
Normal drift 71,6 BTU/t 71,16 BTU/t 71,47 BTU/
| dvale (Standby) 1,706 BTUA 1,706 BTUA 1,706 BTUA
Fra 1,706 BTU/t 1,706 BTU/ 1,706 BTU/t
Stremdiode Til-tilstand: Hvid, Standby-/Sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50/60Hz

Produkt uden fod (B x H x D)

532 x 397 x 209 mm

Produkt uden fod (B x H x D) 532 x 336 x 44 mm
Produkt med fod 3,52kg

Produkt uden fod 3,36kg

Produkt med emballage 4,88kg
Temperaturomrade (drift) 0°C til 40°C
Temperaturomrade (ikke i drift) | -20°C til 60°C

Relativ fugtighed 20% til 80%

el Betjenihg: + 3.658 m (12.000 fod)
Ikke drift: + 12192 cm (40.000 fod)

MTBF 30.000 timer
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4.Tekniske specifikationer

ROHS JA
EPEAT Silver (www.epeat.net)
Emballage 100 % genbrugelig

CE Maerket, FCC Klasse B, GOST, SEMKO, TCO Godkendt (Only

Myndighedernes godkendelser | ¢« lective models), UL/CUL, BSMI, ISO9241-307,CB

Energy star 5.0,PSB,CCC,CECP
Farve Sort
Overflade Blank/Tekstur

@ Bemaerk

1. EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net
for registreringsstatus i dit land.

N

Disse data kan andres uden varsel. Ga til www.philips.com/support for at hente den seneste
version af brochuren.



4.1 Oplesning og forudindstillede
funktioner

El Maksimal oplasning
1920 x 1080 ved 60 Hz (analogt indgang)
1920 x 1080 ved 60 Hz (digital indgang)
B Anbefalet oplesning
1920 x 1080 ved 60 Hz (digital indgang)

3147 720 x 400 70,09
3147 640 x 480 59,94
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
49,70 1280 x 800 59,81

63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
64,67 1680 x 1050 59,88
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00
67,16 1920 x 1080 59,96

© Bemerk

Bemzerk venligst at din skaerm virker bedst med
native oplgsning pa 1920 x 1080 ved 60Hz. For
at opnd den bedste skaermkvalitet, bedes du
venligst bruge denne oplasning.
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5. Stremstyring

Hvis der er installeret et skeermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skeermen automatisk
nedsatte stromforbruget, nar den ikke bruges.
Nar input fra tastatur, mus eller anden input-
enhed registreres, "vagner" skaeermen automatisk
igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug
og signalering:

226V3LA:
VESA )
tilstand Video [V synk | L synk [ Opbrugt strem | LED Farve
. 23,77W (norm.) .
Aktiv TIL Ja Ja 31,6W (maks) Hvid
| dvale . . Hvid
Gy | T || N || MBI || <EEWERD || @i
Kontakt Fra| FRA - - < 05W (typ.) FRA
226V3L:
VESA )
tilstand Video [V synk | L synk [ Opbrugt strem | LED Farve
. 23.25W (norm.) .
Aktiv TIL Ja Ja 2871W (maks) Hvid
| dvale . . Hvid
(Standoy) | A | NeJ | Nej [ <0SWER) 0o
Kontakt Fra| FRA - - < 05W (typ.) FRA

Folgende opsetning bruges til at male
skeermens stremforbrug.

* Indbygget oplasning: 1920 x 1080
* Kontrast: 50%
e Lysstyrke: 250 nits

* Farvetemperatur: 6500k med fuldt, hvidt
mgnster

6 Bemaerk
Disse data kan andres uden varsel.
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6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the

planet

carries the TCO Certified label.
This ensures that your display is

designed, manufactured and tested according to

some of the strictest quality and environmental

requirements in the world. This makes for a high

performance product, designed with the user

in focus that also minimizes the impact on the

climate and our natural environment.

The display you have just purchased

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

21

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is now
requested by users and [T-manufacturers all
over the world. About 50% of all displays world-
wide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)



EPEAT

(www.epeat.net)

ew, e EPEAT (Electronic Product
Qz'o Environmental Assessment Tool)
‘ 7 program evaluates computer

desktops, laptops, and monitors
based on 51 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

»  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

+  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2009 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

¢ MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

6 Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

€ This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Lovmassige oplysninger

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices as described in EN 55022, unless it is spacii-
cally stated that it ia a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 metars). The ussr of the
davics is obligad to take all staps necessary o remove sources of interfarance to tels-
communication or ather devicas.

Pokd neni na fypovém &ithu potstase uvedena, #e spedé dodo tiidy A podie EN 55022,

do tfidy B podie EN 55022. Pro zafizen zafazend do tiidy A (chranné
pésma 30m) podie EN 55022 platl nésleduficl. Dojde-ii k rullan! telskomunikatich nebo

finjich zafizeni e uivatal povinnen provést takova opatfgni, atry rueni odstranil,

fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
Corriger la situation en prenant les mesures Polish Center forTesting and Certification
suivantes: Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit

que celui utilisé par le récepteur. The phasing conductor of the room's electrical

installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou

periphériques. and PN-89/E-06251.

CET APPAREIL NUMERIQUE DE LA CLASSE

B RESPECTE TOUTES LES EXIGENCES DU Wymagania Polskiego Centrum Badan | Certyfikacji
REGLEMENT SUR LE MATERIEL BROUILLEUR t’{g:ﬁ%;ﬂﬁh:ﬁﬁﬂ?ﬁ;ﬁﬂ&‘:’I’.;.".;:.“c?“.’."m?.',’.“n?‘ﬁ:ﬁ‘&'ﬂéﬂ%‘:.‘#.ﬂ“@;%’”m...k
DU CANADA. et et el W i

W el calkewitego wylpeeeia urqdzenia 2 sieer zasilanta, naledy wyjad wiyeeke kabla
easilaigeepo 2 priaedka, Kidre powinno enyidowad sig w pobliz udemna 1 byt Batwo dostepne.
Tnak bespiecaefarw "B potwierdes 2podaosé uresdienia  wynaganiami hezpiceseistwa
wytkowania cowanyini w PN-S3TAZI07 § PR-E 16251

Pozostale instrukeje bezpieczensiva

* i malezy usywad wryezek sdaptercwych Tub usuwaé kolka abwodu achrornego 2 wiyeeki.
Jekeli ‘Loummuucu LRy |l).\.'d|unal:ﬂa o naledy whyd preediurace 3-pylowego 2

System

maleiy przed cagiymi, i wrostami fub spad-

kami napsgei, wiywajec eliminalora praepied, urzadrenia dopasawijcego hi
berzakliceniowegn irodia asilania.

* DNaluiy upewnié sig, sby nic nie lezalo na kablsch systemu komputerowego, araz aby kable nie
byl uimi w ilggsi, adese modna byboby na mie nadeptywad lub porykst slg o e,

* Niemaledy oalewad napoji andinsych plynbw s system komputcrawy.

Nie naleiy wpychat adnych p dve systerm . iy moie

1o spowndwat peiar \uhpm:um\e;r.(dcm poprzes rwarcie lementin wewngtrenych

* Syt kompateeowy pawinen snajdowad sig 2 dals od graejniktw i frédel ciepla. Parsdia,
e ey blakawas atword weniylacyjnych. Nalezy unika bladzensa lafnyel papserdw gud

karmputera w i cyrhalacii powi-
etz wokil niego.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SJOITA LAITE SITEN, ETTAVERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RBAZEARERZIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erfllllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



6. Lovmassige oplysninger
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

PEABLROHS

RIEFPEAR (RFRETSEREFEEMNE (EFAFEKRERHS)
TSI T A ST S SNEBE SNRRNTRNE BN S E
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TG A | x [e] [¢] [e] [e] []
BER/ERE | x [e] [e] [e] [e] o]
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7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter
pa fladskaerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skeerme dog uundgaelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skaerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skerm vare defekte. Desuden seetter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
geelder i hele verden.

sub-pixler sub-pixler  sub-pixler

oy

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primarfarverne red, gren og
bla. Nar mange pixler szettes ssmmen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser, fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er marke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og merke sub-pixler fremstdr som
enkelte pixler i andre farver

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa
skaermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skeermbilledet, nar skeermen viser et
merkt menster. Der er fglgende typer defekte
lyse prikker.

En teendt red, gron eller bld sub-pixel.

I ©

To sammenliggende tendte sub-pixler:
- Red + Bla = Lilla

- Red + Gren = Gul

- Grgn + Bla = Cyan (Lysebld)

Tre sammenliggende teendte pixler (en hvid
pixel).
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6 Bemaerk

En red eller bld lys prik skal vaere mere end 50
procent lysere end de omkringliggende prikker,
mens en gren lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte morke prikker

Defekte merke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er“slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
nar skaermen viser et mgrkt menster. Der er
folgende typer defekte marke prikker.

Ttsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for tetsiddende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skaerm i en Philips
fladskaerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
felgende tabeller:

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
1 teendt sub-pixel 3

2 sammenliggende taendte sub-pixler 1

3 Tre sammenliggende taendte sub-pixler (en hvid pixel) 0

Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
1 meark sub-pixel 5 eller ferre

2 sammenliggende mgrke sub-pixler 2 eller ferre

3 sammenliggende marke sub-pixler 0

Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller ferre

6 Bemaerk
1.
2.

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1SO9241-307 (1S09241-307: Testmetoder for

ergonimiske kray, analyse og overensstemmelse pa elektroniske visuelle skaerme)

28




7.2 Kundeservice og garanti

For oplysninger om garantidaekning og geeldende stattekrav i dit omrdde, bedes du besagge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger iVesteuropa:

Germany Siemens 1&S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

d 3 e e A

Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
;e(;:'; fegm NA Kim Tec d.o.0. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
U NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
R— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 12426331
NA Profi Service +36 1 814 8080

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter
Brazil

- Vermont
Argentina

Kundeservice tif
0800-7254101

0800 3330 856

Kontaktoplysninger til Kina:
Kina
Kundeservice tif: 4008 800 008

Kontaktoplysninger til NORDAMERIKA:

USA TOS Teleplan

(877) 835-1838

Canada Supercom Supercom

(800) 479-6696
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Kontaktoplysninger til APMEA:

Land

Callcenter

ASC

Kundeservice tif

Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand [ NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd- |\, -\ Tel (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 56677
. , . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
Jnited Arab 5 AL SHAHD COMPUTER LLL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
FPT Service Informati +84 8 38248007 Ho Chi Minh City
Vietnam NA Com va Cft g Ormatic +84 5113.562666 Danang City
Py R +84 5113562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no dlls‘mbutor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 97714222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan
klares af brugeren selv. Hvis problemet stadig er
der; efter at du har prevet disse lasninger, skal
du kontakte Philips' kundeservice.

a Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller, at ledningen er sat |
stikkontakten og bag pa skaermen.

* Kontroller farst, at stremkontakten foran
pa skaeermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
*  Kontroller, at der er teendt for computeren.

*  Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede
stikben pa signalkablets stik. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

*  Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

*  Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

*  Tjek, om skeermkablets stikben er bgjede.

* Kontroller, at der er tendt for computeren.

AUTO (AUTOM.) knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Huvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.
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Den automatiske funktion er ikke n@dvendig i
DVI digital-tilstand.

Synlige tegn pa rog eller gnister
* Forsgg ikke selv at fejlfinde

e Treek straks skeermens stik ud af
stikkontakten

* Kontakt straks en repraesentant fra Philips
kundeafdeling.

2] Billedproblemer

Billedet er ikke centreret
* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock
(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skermen
* Tjek, at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

=

o Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.




Billedet er slgret, uklart eller for markt
* Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”,
“brandmaerkerne” eller “spagelsesbillede”,
efter at der er slukket for stremmen.

»  Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pd skaermen.
“Breendmaeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt feenomen
i LCD skaermteknologi. | de fleste tilfeelde vil
“brandmaerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skaermen er blevet slukket.

*  Serg altid for at aktivere en pauseskeerm,
der beveaeger sig, nar skeermen efterlades
uden at blive anvendt.

*  Du skal altid bruge en pauseskeerm eller
et andet program, der opdaterer skeermen
regelmeessigt, hvis LCD skaermen viser
statisk materiale i leengere perioder.

* Alvorlig “brandmaerkerne’- eller
“efterbillede”- eller “sppgelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvranget. Tekst er utydelig eller

sloret.

* Indstil pc'ens skeermoplasning som
skaermens anbefalede, native oplgsning.

Der ses rgde, bld, mgrke og hvide pletter pa

skaermen

*  De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Tendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Taendt” lyset med
Strgmdiode | OSD-menuerne.

For yderligere hjeelp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.
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8.2 Generelle FAQ

SP1: Hvad skal jeg gore, hvis skaermen under

installationen viser “Cannot display

this video mode” (Kan ikke vise denne

videotilstand)?

Sv.. Den anbefalede oplasning pa denne

skaerm: 1920 x 1080 pa 60 Hz.

*  Frakobl alle kabler og forbind derefter

pc'en til skeermen, som du brugte for

* | Windows Startmenuen, vaelg Settings/
Control Panel (Indstillinger/Kontrolpanel). |
Control Panel (Kontrolpanel)-vinduet veelg
Display (Skaerm)-ikonet. | Egenskaber for
Skeerm-vinduet veelg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet “desktop area" (skrivebordsomrade),
skal du stille justeringsbjeelken pa
1920x1080 pixler.

+ Abn “Advanced Properties” (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

» Genstart computeren og gentag trinene
2 og 3 og bekraft, at pc'en er indstillet til
1920x1080 ved 60 Hz.

*  Luk for computeren, frakobl den gamle
skeerm og genforbind Philips LCD skaermen.

*  Tend for skermen og derefter for pc'en.

SP2: Hvad er den anbefalede
opdateringshastighed pa LCD skarmen?
Sv..  Den anbefalede opdateringshastighed
pa LCD skeerme er 60 Hz. | tilfeelde af
forstyrrelser pa skaermen skal du sztte
den op til 75 Hz og se, om dette fierner
forstyrrelserne.

SP3: Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Sv.:  Dette er skeermens driverfiler: Installer
driverne i henhold til brugervejledningen.
Computeren kan bede dig om
skaeermdrivere (.inf og .icm filer) eller om
en driverdisk, nar du installerer skaermen

forste gang. Indszet (medfelgende cd-rom)



SP4
Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8
Sv.:

i pakken i henhold til vejledningerne.
Skaermdrivere (inf og .icm filer) installeres
automatisk.

: Hvordan justerer jeg oplgsningen?

Skaermkortet/grafikdriveren og skaeermen
bestemmer sammen oplgsningerne til
radighed. Du kan veelge den gnskede
oplasning under "“Egenskaber for Skaerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skaermen?

Sa skal du blot trykke pa OK og derefter
vaelge "Reset” (Nulstil) for at ga tilbage il
de oprindelige fabriksindstillinger:

Er LCD-skaermen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udsatte
skaermens overflade for kraftige sted.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sa

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renger jeg LCD skermens
overflade?

Til normal renggring skal du blot anvende
en ren, bled klud. Til kraftigere rengering
skal du bruge isopropylalkohol. Brug

ikke andre oplgsningsmidler sdsom
ethylalkohol, ethanol, acetone, hexan osv.

: Kan jeg ®ndre skarmens farveindstilling?

Ja, du kan andre farveindstillingen via
OSD pa felgende made:
Tryk pa “OK" for at vise OSD (On Screen
Display) menuen

Tryk pa “Down Arrow" (Ned-pil) for
at veelge indstillingen “Color” (Farve),
og tryk derefter pa “OK" for at angive
farveindstillingen. Der er tre indstillingen,
som vist nedenfor.

1. Farvetemperatur med to indstillinger;
6500K og 9300K. Med indstillinger i
6500K omradet virker skaermen “‘varm,
med en rgd-hvid farvetone”, mens en
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9300K temperatur giver en “kold bla-
hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer, skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan velge sin foretrukne
farveindstilling ved at indstille den rede,
grenne og bla farve.

© Bemark

En malning af farven pa lys, der udstrdles fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rede,
hgjere temperaturer sasom 9300K er bla.
Neutral temperatur;, 6504K; er hvid.

SP9: Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
vaere ngdvendig for at kunne forbinde
skaermen til dit Mac-system.Vi anbefaler;
at du kontakter Philips salgsrepraesentant
for yderligere oplysninger:

SP10: Er Philips LCD skaerme “Plug & Play”?

Sv.:  Ja, skeermene er “Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX
og Linux

SP11: Hvad er “billedklebning” eller
“billedindbranding” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spegelsesbilleder” pa skeermen.
“Breendmeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
feenomen i LCD skeermteknologi. | de
fleste tilfelde vil “brandmeerkerne” eller
“efterbilledet” eller “spagelsesbilledet”

Sv.:

Sv.:



8. Fejlfinding og FAQ

forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskarm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskaerm

eller et andet program, der opdaterer
skaermen regelmaessigt, hvis LCD
skeermen viser statisk materiale i leengere
perioder.

O Advarsel

Alvorlig “brandmeerkerne’- eller “efterbillede’”-
eller “spagelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennaevnte skade
er ikke deekket af garantien.

SP12: Hvorfor viser skaeermen ikke skarp tekst?

Sv.:

Hvorfor viser den forrevne tegn?

Din LCD monitor virker bedst pa dens
native oplgsning pa 1920 x 1080 ved

60 Hz. Brug denne oplasning for at opna
det bedste billede.
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